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SEMESTER II        COURSE : A.BVT.2.01/S.BVS.2.01     

 

BUSINESS COMMUNICATION - II  

 
LEARNING OBJECTIVE: 

 To facilitate advancement in career based on students’ need to present his or her 

personality efficiently. 

 To equip the students with the necessary speech skills/basic writing skills for 

professionally interacting with others in an effective manner 

 

 [Total Lectures 45] 

 

Unit1   Advanced Communication Skills     Total Lectures: 12 

1. Initiating, Sustaining and Closing a Business Conversation. Selling skills : closing a sale  

2. Participating in Business Discussions  

3. Making Formal Speeches 

4. Diction and pronunciation. 

Unit2   Telephone Skills               Total Lectures: 11 

1. Agreeing and Disagreeing in Industry 

2. Appointments and Friendly Reminders 

3. Making and Handling Complaints 

Unit3   Internet Communications Skills                                      Total Lectures: 11  

1. Drafting business e-mails 

2. Attending to queries 

3. Email etiquette. 

4. Writing blogs and articles. 

Unit4   Office Communication              Total Lectures: 11 

1. Presentation Techniques including making power point presentations. 

2. Group Discussions 

3. Situational Role Play 

Continuous Internal Assessment  

Assignments / Projects/ Presentations/ Written Test etc.  

 

References:  

1. Morris and Smith, Business Writing, Orion Business Toolkit 

2. Thomas Huskin and Leslie Olsen, Technical Writing and Professional Communication, 

McGRAW-HILL International Editions 

3. Jane Dorner, Writing for the Internet, Oxford University Press 



4. Paul Nelson and Judy pearson, Confidence in Public Speaking, Jaico Publishing House 

5. L. Sue. Baugh, How to Write First Class Business Correspondence, Viva Books Pvt. 

Limited 

 

 

 

SEMESTER II        COURSE : A.BVT.2.02/S.BVS.2.02     

EFFECTIVE FRENCH SKILLS - II 
LEARNING OBJECTIVE: 

 Discover a few aspects of French life: people food customs… 

 Learn basic vocabulary to express simple sentences to talk about oneself. 

 Acquire basic communication skills to buy something, to ask for/give directions. 

 Develop skills and confidence to converse in a very basic manner with a French speaking 

person beyond introductions. 

 

 [Total Lectures 45] 

Unité 5 

 

Objectifs de communication:Thème: Ma chambre/Ma maison/Ma ville 

Parler de sa chambre .Situer dans l’espace. 

 

Grammaire 

Il y a un/une/des…….dans ma chambre 

Les prépositions: sur,sous,devant.derrière,à coté de , près de ,pour localiser les objets. 

Les nombres :premier, deuxième…dixième 

Négation :ne –pas 

Impératif 

 

Phonétique 

Les voyelles nasales 

 

Culture et Civilisation 

La carte de France pour voir les villes importantes en France 

Ou L’importance  de quelques villes en France.. 

Quelques coûtumes françaises. 

 

 

Thèmes tâches et projets: 

Décrire sa chambre/sa ville-phrases simples  (genre-il y a une poste,un cinéma…. ) 

Remplir avec du vocabulaire et des verbes  une petite histoire simple 

Localisation des objets. 



Lecture à voix haute 

 

 

II Unité 6 

 

Objectifs de communication: Les repas  

Parler des repas du jour 

Savoir dire L’heure et la date 

 

Grammaire 

Les articles partitifs 

Verbes –faire/dire 

Les adjectifs démonstratifs 

 

 

Phonétique 

Opposition {u} {Y} 

 

Culture et Civilisation 

Les spécialites gastronomiques en France 

Les repas en France et en Inde 

Commander un plat au restaurant/dans un fast-food. 

 

 

Thèmes tâches et projets 

 Parler des repas en France 

Parler des spécialités gastronomiques ou quelques  phrases sur une ou  deux fêtes 

importantes:exemple Pour la fête de Sankranti on mange../on porte.. /on donne…/ 

 

 

III Unité 7 

 

Objectifs de communication:Theme:Les vacances 

Parler des goûts /des passetemps et des vacances 

 

Vocabulaire: 

Parler de ses activités. 

Parler de ses loisirs 

Quelques vêtements  

 

Grammaire 

Les interrogations:Qui/Quand/comment/pourquoi? 

Prépositions à/ chez 

Les adjectifs possessifs 

 

Phonétique 



  Intonation des phrases déclaratives./interrogatives 

 

Culture et Civilisation: 

La carte de France avec ses régions importantes. 

Quelques sites touristiques . 

 

Thèmes tâches et projets: 

Remplir une carte postale à trous. 

Acheter un souvenir/un t.shirt  dans un magasin de souvenirs. 

 

Continuous Internal Assessment:  

 

Evaluation will be based on oral and written continuous tests in class. 

 

References: 

Select Bibliography: 

Publication  

Hachette: 

1 Bien Joué1 

2 Alter Ego 1 

3 Le kiosque 

Clé International 

1 Amis et Compagnies 1 

2 Grammaire Progressive du Français 

Hatier 

1 Premiers Exercices de Grammaire 

 

Magazine Langers publication  

On y va  

 

Video Methods: 

1 Taxi 

2 Connexions 

 

 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 

SEMESTER II        COURSE : A.BVT.2.03/S.BVS.2.03     

GIVING VOICE TO VALUES  

 
LEARNING OBJECTIVE: 

 To familiarize students with foundational value concerns.  

 To help students to critically analyse and develop their own values.  

 To enable students to take practical steps to act on their values. 

 

 [Total Lectures 45] 

 

UNIT– I: Value Clarification [5 lectures]  

 What is a value?  

 Exercises to reveal values.  

 Value Formation. 

 

UNIT – II: Comparative Religions [7 lectures]  

 Inter-religious sensitivity: main ideas from the major religions 

 Sharing Faith: what is the religious meaning that is precious to you  

 Breaking through stereotypes  

 Communalism and Building community 

 

UNIT- III: Corruption as a way of life [5 lectures]  

 Case studies e.g. CWG, Adarsh, 2G, Coalgate… 

 Attempt to analyse causes  

 Strategies to avoid corruption: RTI, Civil society groups, other strategies to bring  

 accountability and transparency 

 

 

UNIT – IV: Violence and Conflict Resolution [5 lectures] 

 Understanding violence and conflict 

 Causes and forms of violence and conflict 

 Conflict resolution 

 

UNIT - V: Youth and Substance Abuse [6 lectures] 

 Substance abuse - Causes and symptoms 

 Forms of substance abuse - Alcoholism, Drug addiction, Smoking 

 Preventive and curative measures 

 

UNIT – VI: The problem of evil [4 lectures] 

 Conceptualising evil 

 Manifestations of evil 



 Mitigation         

 

UNIT – VII:  Prayer - communal and personal [3 lectures] 

 What is prayer? 

 The importance of prayer and silence in one’s life 

. 

UNIT – VIII: Critical Thinking [3 lectures] 

 What is critical thinking? 

 The value of critical thinking 

 Analysis of Newspapers, TV, Film 

 

UNIT – IX: Ethical Relationships [7 lectures] 

 Young People: Suicide, Depression, Ragging 

 Causes and symptoms 

 Coping strategies 

 

Continuous Internal Assessment: 

 

Presentations / Tests / assignments 

 

References: 

 

 In Harmony: Value education at college level- Department of Ethics and Religious 

studies, Loyola College, Chennai. 

 Y Masih , Introduction to Religious Philosophy – (Chapters- 1, 2, 13, 15) 

 Godfrey Harris , Corruption: How to deal with its impact on Business and Society-. 

 Irwing G Sarason and Barabara Sarason, Abnormal Psychology ( Chapter- 13- 

Substance Abuse: Drugs / Alcohol)-  

 

Resources: 

Film: The Four Religions – Arnold Toynbee 

Film: The Seven Circles of Prayer – Martin Smith 

Film: God in the Dock – Ellwood Kieser 

Film: Teenage depression and suicide – Andrew Schlessinger 

Film:  Portrait of addiction- Moyers collection on DVD- Films for Humanities and 

sciences. 

 

 
 
 
 
 
 
 
 



SEMESTER II        COURSE : A.BVT.2.04/S.BVS.2.04     

         

ELEMENTS OF DIGITAL DESIGN 

 
LEARNING OBJECTIVE:  

Learn to explore the beauty of digital design software from the practical to the painterly 

artistic. In 45 sessions, practice the editing concepts to understand how Photoshop will help 

to create successful customized images. 

 
 

[Total Lectures 45] 

 

Unit 1 - Getting started with Photoshop                        Number of lectures 10 

 
 Fundamentals of Photos editing softwares 

 What new in photoshop 

 Basics of Images 

 Vector Images 

 Bitmap Images 

 Interfacing with the Photoshop Desktop 

 Working with The Menu Bar and Tool Box 

 File and Edit Menus 

 The Image Menu 

 The Layer Menu 

 The Select Menu 

 The Filter Menu 

 The View Menu 

 The Help Menu 

 ToolBox 

 New Features in Photoshop 

 Custom Brushes 

 Healing Brush 

 Picture Package 

 Web Photo Gallery 

 Spell Checking 

 Opening Recent Images 

 Importing Images 

 PDF Image 

 

 Annotations 

 WIA Support 

 Placing Images 

 Optimizing Images 



 File Browser 

 PDF Security 

 Understanding the Selecting Tools 

 Rectangular Marquee 

 Move Tool 

 Lasso Tool 

 Magic Wand 

 Painting and Drawing Tools 

 Editing and Retouching Tools 

 Background Eraser (E) 

 Erasing Image Background Color 

 Guides, Grid and Slices 

 Transform 

 Layers 

 Effects 

 Filters 

 Using the Color Tools 

 Working with Palettes 

 Actions palette 

 History Palette 

 Swatches Palette 

 Brushes Palette 

  

Unit 2 - Painting & drawing Tools                                Number of lectures 8 

 

Using The Brush and Pencil Tool 

 Choosing a Brush Size 

 Picking a Painting or Drawing Mode 

 Setting Opacity And Flow 

 Using Airbrush Mode 

 Blending with the Smudge Tool 

 Loading Brush Sets 

 Working With The Brushes Palette 

 Renaming Brush Presets 

 Deleting Brush Presets 

 Working with the Healing Brush 

 Patching Images 

  

Unit 3 - Color Management in Photoshop                              Number of lectures 9 

 

    Applying Colors to your Image 

 Using the Color Picker 

 Selecting Colors with the Eyedropper Tool 

 Working with Color Channels 



 Displaying and Hiding Channels 

 Mixing Color Channels 

 Working with the Color Table 

 Using Auto Color 

 Using Special Color Effects 

 Inverting Colors 

 Working with Color Thresholds 

 Equalizing Colors 

 Posterizing Images 

 Creating a Gradient Map 

 Desaturated Colors 

  

Unit 4 - Working with Layers Session 27:                    Number of lectures 7 

 Layer concepts 

   Creating New Layers 

 Activating a Layer 

 Duplicating Layers 

 Arranging Layers 

 Working with Layer Locks 

 Deleting Layers 

Creating Layer Based Slice 

 

Unit 5 - Using fills & styles Session 31:                               Number of lectures 11 

 

 Using the Pattern Stamp Tool 

 
 Applying Pattern Fills 

 Working with Styles Palette 

 Understanding the Gradient Tool 

 Customizing a Gradient 

 Applying a Gradient 

 Working with the Pattern Maker 

 Creating your Own Patterns 

 Working with the Layer Style Dialog Box 

 Customizing Blending Options 

 Drop Shadow 

 Inner Shadow 

 Outer Glow 

 Inner Glow 

 Bevel and Emboss 

 

Continuous Internal Assessment 

Assignments / Project 



Mid Term test. 

 
List of Text Books: 

 
 Photoshop(R) 7: The Complete Reference 

by Laurie Ann Ulrich (Author) 

 
   Photoshop CC: 

by Lesa Snider (Author) 

 

 

List of Practicals: 

  

Experiment 1. Moving objects from one layer to another using layer properties. 

Experiment 2:Painting objects with Gradient and enhancing colour values 

Experiment 3. Applying black and white ecffect to perticular object in image. 

Experiment 4. Applying motion filter effect. 

Experiment 5:Implementation Lens flare, colour lense & light reflection 

Experiment 6.Applying dispersion effect. 

Experiment 7. Implementation of water illusion effect. 

Experiment 8.Creating Gallery  

 

http://www.amazon.com/s/ref%3Ddp_byline_sr_book_1?ie=UTF8&amp;text=Laurie%2BAnn%2BUlrich&amp;search-alias=books&amp;field-author=Laurie%2BAnn%2BUlrich&amp;sort=relevancerank
http://www.amazon.com/Lesa-Snider/e/B00376ZIHO/ref%3Ddp_byline_cont_book_1
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B. Voc. (Software Development) Semester II                               COURSE: S.BVS.2.05 

         

Title: PHP with MySQL 

 

Learning Objective:  

To equip with PHP for making dynamic web pages and deploy it over server. Students can 

apply this skill for getting job as a web developer. 

Number of lectures: 45 

============================================================== 

UNIT 1          (15 lectures) 

 

PHP Basic, Arrays and Functions, Class in PHP       

Understand PHP software environment. PHP Basic syntax, PHP data Types, PHP Variables, 

PHP Constants, PHP Expressions, PHP Operators, PHP Control Structures, PHP Loops. 

Array declaration, PHP Associative Arrays, Array Iteration, PHP Multi-Dimensional Arrays, 

Array Functions.PHP Functions, Syntax, Arguments, Variables, References, Pass by Value & 

Pass by references, Return Values, Variable Scope, PHP include(), PHP require(). 

Class, object, Inheritance, Constructors and destructors Class Inheritance. 

 

UNIT 2          (15 lectures) 

String and File handling, Form and Session, JQuery and Ajax 

Strings and Patterns, Matching, Extracting, Searching, Replacing, Formatting. 

File Handling reading and writing 

PHP Form handling, PHP GET, PHP POST, PHP Form Validation, PHP Form 

PHP Cookie handling, PHP Session Handling, PHP Login Session, Managing user Account, 

Using HTML,CSS, JQuery and Ajax in PHP. 

 

UNIT 3          (15 lectures) 

MySQL , Integration with PHP 

Working with PHPMyAdmin. Create, delete and update record, Retrieving specific record. 

Understand CRUD operation, working with MySQL Truncate, MySQL Drop. WHERE 

condition, Order By, Group By, Having, LIKE, AND OR operators 

Importing and Exporting CSV Files. Creating an application in PHP. 

 

 

TEXT BOOKS 

1. Head First PHP and MySQL – O’relly  Publication.  

 

REFERENCES BOOKS 

1. PHP – Complete Reference – TMH Publication  

 

Website 

1) http://www.w3schools.com/php/ 

 



 

 

B. Voc. (Software Development) Semester II                               COURSE: S.BVS.2.06 

 

OPERATING SYSTEM 

 

Learning Objective:  

To develop the understanding the fundamentals of modern operating system 
 

Number of lectures: 45 

 
Topic No. Of 

lectures 

 
UNIT 1 : Introduction To Operating System 

 History of Operating System, 

Types of Operating System 

Batch, Multiprogramming,  

Multitasking,  

Real-Time 

Operating System Structure-Layered, Monolithic, Microkernal 

07 

UNIT 2 Processes and Deadlock 

Process Management, Creation, Termination, 

Process States 

Thread Model and Implementation,  

Interprocess Communication & Synchronization 

Race Condition, Critical Region, Mutual Exclusion, 

Semaphores,Monitiors 

Classical IPC Problems 

Dining Philosophers Problem, 

Readers and Writers Problem 

Process Scheduling(Preemptive and Nonpremptive), 

Deadlock 

Deadlock Detection And Recovery 

Deadlock Avoidance, 

Deadlock Prevention 

15 

UNIT 3 Memory Management  

Static Allocation, Dynamic Allocation, 

Segmentation, Paging, Virtual Memory, 

Page Replacement Algorithms 

08 

UNIT 4 File System 

Files Naming, Structure, Types, Attribute 

File System Implementation 

Directory implementation 

08 



Allocation methods 

File sharing NFS 

Storage Structure: Disk Structure,  

Disk Management,  

Disk scheduling 

RAID Structure 

UNIT 5 IO Systems 

IO hardware 

DMA 

I/O interface 

Kernel I/O subsystem 

Introduction to STREAMS 

Distributed Operating System 

Introduction to Distributed Operating System 

Goals, Hardware Concepts, 

Software Concepts, Design Issues 

Types of distributed operating systems : NOS-remote login, remote file transfer, data 

migration, computational migration, process migration 

 

07 

 

 

Books: 

Modern Operating Systems,  Andrew Tanenbaum,  

Operating System Concepts, 8th Edition, Abraham Silberschatz, Peter B.Galvin, Greg Gagne, Wiley 

publication 

Operating Systems, 2nd Edition, K. A.Sumitra Devi and N.P Banashree, SPD 

 

Reference: 

Operating Systems- A concept based approach , 2nd Edition, D.M. Dhamdhere, McGrawHill 

publications 

Operating Systems,  3rd Edition , Godbole and Kahate, McGrawHill publications. 

 

 

 

 

B. Voc. (Software Development) Semester II                               COURSE: S.BVS.2.07 
 

DBMS / Structured Query Language (SQL)      
 

Learning Objective:  

To learn the concept of database systems and software techniques for manipulating and 

maintaining databases 

 

Number of lectures: 45 
 

Unit 1 : Introduction to Databases                                                                   5 Lectures 

What is database system, purpose of database system 



Data models-file management systems, hierarchical databases, network databases 

Relational data model- Primary key, foreign key, relationships 

Codd’s 12 rules 

ER Diagrams 
 

Unit 2 :Creating a database                                                                              15 Lectures 

Table definitions - creating a table, drop a table, alter table, table aliases 

Database updates-insert, update, delete, Adding data to the database, deleting data from the 

database, modifying data in the database 

Data Integrity-What is data integrity, simple validity checking, integrity constraints, referential 

integrity 

 

UNIT 3 : SQL Basics                                                                                         15 Lectures 

Simple Queries-Select statement, FROM clause, duplicate rows(DISTINCT), row selection, 

search conditions, sorting query results 

Summary queries-Column functions(SUM, AVG, MIN, MAX, COUNT), grouped 

queries(GROUP BY clause) 

 

UNIT 4 :Subqueries                                                                                           10 Lectures 

What is a subquery, subqueries in WHERE clause 

Subquery search conditions-subquery comparison test(=, <>, <, <=, >, >=), set membership 

test(IN), the existence test(EXISTS), quantified tests(ANY and ALL) 

 

Continuous Internal Assessment  

Assignments / Project 

Mid Term test. 

 

References :  

Text Books 

1. James R. Groff and Paul N. Weinberg, “SQL- The complete reference”, Second 

edition Tata McGraw-Hill 

 

 

 

 

 

 

B.Voc (Software Development) Semester II                                           Course: S.BVS.2.08 
 

 

 Object Oriented Programming using JAVA 

 
Learning Objective:  

 

To learn Core Java fundamentals, To understand how java is used in object oriented 

programming. To develop strong foundation for building projects in java. 



 

[Total Lectures 45] 

UNIT 1 : Classes in java                                                                                          [8] 

General form of a class, declaring Objects, introducing Methods, Passing different parameter to 

method like int, double, String ,String[], Object , Constructors and types of  Constructors, this 

keyword, Understanding Object class and its methods 

 
UNIT 2: Inheritance, Packages and Interfaces                                                     [10] 

Inheritance 

Inheritance basics, 

using super,  

creating multilevel hierarchy,  

method overriding,  

dynamic method dispatch,  

using abstract classes ,  

using final 

Packages, Access Protection,  

Importing Packages,  

Defining a Package, Finding Packages and CLASSPATH 

A Short Package Example, 

Access Protection, An Access Example,  

Interfaces, Defining an Interface 

implementing Interfaces,   

Variables in Interfaces, 

Interfaces Can Be Extended 

UNIT 3 : Collection Framework and Exceptional Handling                            [10] 

Collection interface 

Collection classes 

ArrayList, Vector, HashSet, Using Iterator 

 

 

Exception handling 

Exceptional Handling fundamentals, 

Exception Types Uncaught Exceptions, 

try and catch, multiple catch clauses, 

nested try statements, throw, throws 

finally 

 

UNIT 4 : JDBC  and Swing                                                                                  [10] 

Steps to connect to database from Java 

Understanding ResultSetMetadata interface 

Creating GUI  with JTextField, JButton, JComboBox, JLabel, JRadioButton, JCheckBox. 

Understanding Layouts GridLayout, FlowLayout, BorderLayout 

Create Login screen and authenticating from database 
 

UNIT 5 : String Handling                                                                                      [7] 



String constructor, Character extraction, charAt(), getChars(), toCharArray() 

String comparison, equals() and equalsIgnoreCase(), startsWith(), endsWith() 

compareTo(), Modify a string, substring(), concat(), replace(), trim(), StringBuffer 

Constructor, length() and capacity(), charAt(), insert(), append(), reverse(), delete() and 

deleteCharAt(), replace(), substring() 

 

Continuous Internal Assessment 

Assignments / Project 

Mid Term test. 

List of Text Books: 

1. Java 2 Complete Reference by Herbert Schildt . --TMH Publication 

 

List of Recommended Reference Books 

 

1. Java 2 Programming Black Book, Holzner 

2. Programming with Java,E Balagurusamy  

 

 
 

 

 

 

B. VOC (Software Development)                                                         Course: S.BVOC.2.PR 

 

PRACTICALS 

 
Practical list for PHP with MySQL  

Practical No 1 

Create Textbox and Button on screen. In Textbox user writes the string and on click of Button 

the string gets reversed using PHP. 

Practical No 2 

Develop UI using PHP Application for Basic Calculator showing functionality for ADDITION, 

SUBSTRACTION, MULTIPLICATION and DIVISION.  

Practical No 3 

Develop a UI for to accept Registration Details of a student such as RNO, Name, DOB, 

GENDER, COURSE, HOBBY, HSC PERCENTAGE, ADDRESS, PHONE, EMAIL and 

CATEGORY. Now store these details in MySQL database on click of ADD button.  

Also when the user puts only RNO and clicks on SEARCH button all data related to that student 

gets displayed. 

Practical No 4 

Develop a PHP Application to Authenticate User and password. If login is successful then 

forward user to result Page which shows the result of that student in proper report otherwise 

shows login failure Message. Also user should not be allowed to vist any page without proper 

login. 

Practical No 5 

Integrate Regular expression in PHP to do validation and then store the details in MySQL. 



1)email 

2)phone no beginning with 011 

3)mobile no 10 digits and starts with 8 or 9 or 7 

4)emp name 

5)dob 

Now display the name and dob of  all employees who all are >30 years age on click of  

DISPLAY button. 

Practical No 6 

Integrate Ajax with PHP to search check whether the email already exists during registration of 

the user on a website. 

 

Practical No 7 

Create UI with File selection option and on selection, it displays the content of file on TextArea. 

Also give feature for modification of file. 

Practical No 8 

Design screen for inventory of a shop showing 

ITEM NO  DESCRIPTION QTY  UNIT PRICE  TOTAL 

Enter appropriate information. On entering ITEMNO it automatically shows UNIT PRICE and 

DESCRIPTION from the database. User enters QTY and TOTAL gets auto listed. After entering 

all records(say 5 rows or more) GRAND TOTAL gets listed. 

 

 

Practical No 9 

Integrate JQuery and session, cookies with PHP and create shopping cart application for mobile 

phones. 

Practical No 10 

On entering DOB in text box and submitting, it displays the age of person in years month and 

days. 

Note: Complete any 8 from the above list. 
 

 
MOS PRACTICAL LIST 

 

1. Create a Shell Program for accepting first name and last name as argument  

2. Write a Shell Program for finding whether a number is even or odd 

3. Write a Shell Program for finding the sum of digits of a given number. 

4. Write a Shell Program for finding maximum of 3 numbers 

5. Write a Shell Program for accepting percentage and displaying grade 

6. Write a Shell Program for accepting date and display day assuming date 1 is  

7. Write a Shell Program for displaying factorial of a number  

8. Write a C Program for finding all prime numbers within a given range 

9. Write a C Program for checking whether a word is a palindrome or not 

10. Write a C Program for displaying Fibonacci series 

 

 
 



PRACTICAL LIST FOR DBMS/SQL 

 

Learning Objective:  

To introduce the concept of databases and to use SQL software for handling large data 

operations using queries. 

 

List of practicals: 

 

I) Design a table with the given fields. Use the drop table and alter table commands on 

the created table. 

II) Use the insert, update and delete commands on the tables. 

III) Apply the constraints like Primary Key , Foreign key, NOT NULL to the tables. 

IV) Write a SQL query to select data from tables. 

V) Write a SQL statement for implementing ALTER,UPDATE and DELETE 

VI) Write a query to implement the concept of Integrity constrains 

VII) Write a query for implementing the following functions: 

 SUM(),MAX(),MIN(),AVG(),COUNT() 

VIII)  Write a subquery in the where clause of the main SQL query using the subquery 

comparison test(=, <>, <, <=, >, >=), set membership test(IN), the existence 

test(EXISTS) 

 

Assessment: 

CIA and End Semester Exam based on the practicals will be conducted. 

 

 

 

JAVA PRACTICAL LIST 

 

Learning Objective:  

To introduce the concept of object oriented programming using JAVA programming language. 

 

List of practicals: 

 

1. Design a program to implement the concept of a class, object and methods 

Define a class Box with instance variables height, length and breadth and methods 

volume() and area() to display the volume of the box and area of base of the Box. 

Define a method getData() to initialize the instance variables. Create 2 objects of this 

class and display the area and volume. 



Also implement the concept of constructors and type of constructors (parameterized 

constructors) 

2. Design a program to implement the concept of inheritance 

Create a class Rectangle that includes the data member for length and width as well 

as constructors to assign values and methods to display them. Derive a class named 

block that contains additional members to store height and constructors to assign the 

values and method to display the height. 

3. Design a program to implement interfaces 

4. Create a login screen and authenticate the user by matching username and password 

through database 

5. Design a GUI application to input the name, roll no and marks of five subjects and 

display the percentage of the student 

6. Design a program to implement exception handling : try and catch, throw, throws 

finally 

7. Design a program to implement String handling functions 

8. Write java program to find whether the string is a palindrome or not 

 
 

Assessment: 

CIA and End Semester Exam based on the practicals will be conducted. 
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